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Abstract
This is a protocol for creating Post-Bisul�te Adapter Ligation \(PBAL) libraries from single cells to assess
the state of DNA methylation genome-wide at a single base-pair resolution.

Reagents
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Name Supplier Model or
Catalogue #

Ultrapure DNase/RNase-Free Distilled Water Thermo Fisher
Scienti�c

10977-015

Qiagen Elution Buffer Qiagen 19086

1M KCl Sigma 60142-500ML-
F

1M Tris-HCl –pH 8 Invitrogen 15568-025

1 M Tris-HCl –pH 7.5 Invitrogen 15567-027

Triton X-100 Sigma X100-500ML

SDS Sigma L3771-500G

Protease K QIAGEN 19131

100% Ethanol Commercial
Alcohols

 

DNase I with 10X buffer Thermo Fisher
Scienti�c

AM2222

MethylEdge Kit Promega N1301

MagSi-DNA all-round Magnetic silica beads \(20mg/mL) MagnaMedics MD01018

Custom Random Hexamers IDT Custom order

Klenow Fragment \(3'-->5' exo-) \(50,000 units/ml) NEB M0212M

NEB 2 buffer NEB M0212M

10mM dNTP BIOLINE BIO-39049

Phage T7 DNA \(full methylation of the genome prepared in
house)

GeneON 310-005

Unmethylated Lambda DNA Promega D152A

DNA Library Prep Reagent Kit NEB E6000B-10

Phusion U Hot Start DNA Polymerase Thermo Fisher
Scienti�c

F555L

Illumina PET small forked adapter IDT Prepared in
house

PCR primer 1.0 IDT Diluted to
25uM

PCR primer 2.0 indexing primers IDT Diluted to
12.5uM
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qPCR primer - human speci�c IDT Customized

qPCR primer - mouse speci�c IDT Customized

KAPA Library Quanti�cation kit -Illumina \(includes qPCR
primers for library quant)

KAPA
Biosystems

KK4824

SeraMag SpeedBeads Carboxylate-modi�ed Made in house or Ampure XP
beads

3M Sodium Acetate pH 5.5 Ambion AM9740

Mussel Glycogen Sigma G1767

High Sensitivity DNA kit Agilent 5067-4626

Qubit dsDNA HS Assay Kit Thermo Fisher
Scienti�c

Q32851

Qubit Fluorometer Thermo Fisher
Scienti�c

Qubit 2.0

AB 1400 96 Well plate     \(reservoir only) Thermo Fisher
Scienti�c

AB-1400-L

Eppendorf PCR 96-LoBind \(for DNA) Eppendorf 0030129504

Lab Marker, Fine, Black VWR 52877-310

DNA LoBind 2.0mL tubes Eppendorf 022431048

Qubit Assay tubes Thermo Fisher
Scienti�c

Q32856

Gilson P2 pipetman Mandel F144801

Gilson P10 pipetman Mandel F144802

Gilson P20 pipetman Mandel F123600

Gilson P100 pipetman Mandel F123615

Gilson P200 pipetman Mandel F123601

Gilson P1000 pipetman Mandel F123603

Thermo Mixer Eppendorf 5382000023

Multi 12-channel Pipette P20 Rainin 17013803

Multi 12-channel Pipette P200 Rainin 17013805

Clear Plastic Plate Cover \(not for PCR) Edge Bio 48461

PCR cover Bio Rad MSD-1001

Microseal ‘F’ foil Seals \(metal covers) Bio Rad MSF 1001
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Eppendorf 5810R centrifuge \(tube) Eppendorf  

Eppendorf 5424R centrifuge \(plate) Eppendorf  

ViiA 7 Real-Time PCR System Applied
Biosystems

 

MicroAmp Optical 384-well reaction plate Applied
Biosystems

4309849

MicroAmp Optical Adhesive �lm Applied
Biosystems

4311971

Agilent 2100 Bioanalyzer Agilent G2939BA

SafeTouch Advanced Stretchy gloves Medicom 1137 A, B,C,D

MAGNUM FLX magnet Alpaqua A000400

Vortex Mandel S0100A

Table Minifuge Mandel C1801

1.2 mL Storage Plate Thermo Fisher
Scienti�c

AB-1127

Axygen 96 square deep-well Axygen P2MLSQCS

Axygen Assay Plate Axygen P96450VCS

P10 Pipette tips Gilson DFL10ST

P100 Pipette tips Gilson DFL100ST

P200 Pipette tips Gilson DFL200ST

P20 Pipette tips Gilson DFL20ST

P1000 Pipette tips Gilson DFL1000ST

Biological Safety Cabinet \(housing for Bravo) Baker Class II Type
A2

Laminar �ow hood \(PCR workstation) Erlab Biocap 391

Bravo Automated Liquid Handling Platform Agilent Bravo

UV crosslinker Analytik Jena CL-1000

RNase Away \(4X4L) Fisher Scienti�c 14-754-34

DNA Away \(250mL) ThermoFisher 7010PK

CoolRack XT PCR96 \(for plates) BioCision BCS-529

TruCool® Midi 4L Ice Pan BiCision BCS-113

50mL Falcon tubes Fisher Scienti�c 1443222
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CoolRack® M15 \(for tubes/enzymes) BiCision BCS-125

DNA LoBind tube 1.5mL Eppendorf 022431021

DNA LoBind tube 0.5mL Eppendorf 022431005

MicroAmp™ Adhesive Film Applicator ThermoFisher 4333183

CoolRack XT PCR384 BiCision BCS-538

     

1. Oligos

2. qPCR primer for human \(HG19)

Forward: 5’-TGTTTGTAAAGTTTATAAGTGGATA-3’

Reverse: 5’-CAAAAAAATTACTAAAAATTCTTCT-3’

2. qPCR primer for mouse \(mm10)

Forward: 5’-AAAATTGAAAATTATGGAAAATGAG-3’

Reverse: 5’-CCAAATCCTTCAATATACATTTCTC-3’

3. qPCR primers for library quanti�cation \(supplied in the Kapa Lib Quanti�cation Kit - Illumina)

Forward \(P1): 5’-AAT GAT ACG GCG AC ACC GA-3’

Reverse \(P2): 5’- CAA GCA GAA GAC GGC ATA CGA-3’

4. Illumina PET small forked adapter oligos \(PAGE puri�ed and hybridized together):

         DNA Oligo 1:   5’- /5Phos/GAT CGG AAG AGC GGT TCA GCA GGA ATG CCG AG -3’

                                                 Note: 5’ Modi�cation: Phosphorylation

 

   DNA Oligo 2: 5’ - ACA CTC TTT CCC TAC ACG ACG CTC TTC CGA TC**T - 3’

                                                 Note: 3’Modi�cation:  **T is a phosphorothioate bond

5. PCR Primers \(GSC construct):
Primer 1.0: 5’-AAT GAT ACG GCG ACC ACC GAG ATC TAC ACT CTT TCC CTA CAC GAC GCT CTT CCG
ATC T -3’



Page 7/60

Indexing primers 2.0 \(GSC construct):   5’-CAA GCA GAA GAC GGC ATA CGA GAT NNNNNN CGG TCT
CGG CAT TCC TGC TGA ACC GCT CTT CCG ATC T-3’

�. Custom Random Hexamers

5’- NNNN**N**N-3’ Note: Modi�cation: *=phosphorothioate bond)

 

Procedure
1. Procedure

2. General Guidelines

1. Read this entire document and EGL005.03 96 well Library Construction using Agilent Bravo
SOP before starting this procedure for the �rst time.

 

2. Given the nature of single cell work, it is crucial to always wear gloves when handling sample
plates, reagents and equipment, and to treat everything with clean PCR techniques. Use two layers of
gloves and switch the outer gloves anytime something outside of the dedicated single-cell laminar
�ow hood is handled. Use a disposable lab coat throughout this procedure.

 

3. All work should be performed inside a dedicated single-cell work only enclosed PCR workstation
and an enclosed Bravo liquid handler.

 

4. Before starting, turn on the PCR workstation, place a clean autoclave bag in the waste container,
clean all work surfaces and equipment such as pipettes, centrifuge, vortex thoroughly with RNAse
Away or DNA Away spray.

 

5. Use Eppendorf LoBind PCR clean plates for samples and the less expensive AB-1400-L plates as
reservoirs.

 

6. Seal all plates with a plastic EdgeBio cover every time they exit the hood and never re-use covers.
Use MicroAmp adhesive �lm applicator to create a good seal around each well.
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7. Keep the samples and brews on ice. Enzymes should only be taken out of the freezer just before
addition to the brew, transported only in a designated pre-chilled to -20°C cold-block \(CoolRack
M15), then immediately returned to the freezer.

 

8. Plates should never be vortexed. Plate mixing steps are only to be done using 12-channel pipette
or using the Bravo.

 

9. When placing plates on the Bravo deck, make sure that the A1 well is always in the upper left
corner.

 

10. All reagents except enzymes should be aliquoted for single use. All buffers should be well mixed
by repeated pulse-vortexing before addition to the brew.   All brews should be well mixed by repeated
gentle pulse-vortexing before dispensing into reservoir to assure an equal distribution of all
components and thus uniformity of enzymatic treatments across a plate.

 

11. At the end of each working day, discard all used plastic ware and remove the waste bag �rst, then
wipe down all work surfaces with RNase Away or DNA Away.

 

 

 

2. Reagents to prepare in advance

1. Spike-In mix preparation:

 

1.1. In a LoBind 1.5mL PCR clean Eppendorf tube, prepare equal mass mix of: methylated T7 gDNA
and unmethylated lambda gDNA and dilute to 20ng/uL with Qiagen EB buffer. Aliquot for single use
and store at -20°C. Prepare 1ng/uL dilution of the mix using Qiagen EB buffer, check the quant using
Qubit HS Assay, aliquot for single use, and store at -20°C for up to 3 months.
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1.2. Retrieve one aliquot of 1ng/uL Spike-In mix and dilute to 6pg/uL using Qiagen EB buffer, mix
very well by repeated pulse-vortexing, and aliquot single use. Store in a LoBind Eppendorf tubes at
4°C for up to two weeks \(scPBAL Box).

 

2. Positive control preparation:

 

2.1. In a LoBind 1.5mL PCR clean Eppendorf tube, prepare 2.5ng/uL dilution of HL60 gDNA using
Qiagen EB buffer, mix very well by pipetting \(do not vortex), and check the quant using Qubit HS
Assay. Aliquot for single use \(6uL/tube) and store at -20°C for up to 6 months.

 

DAY 1

3. Single cell Lysis

1. The input for this procedure is a plate containing single cells \(or nuclei) sorted into 384-well
plate \(Quadrant A only – see image below for sorting plate layout) and snap frozen dry in liquid
nitrogen or ethanol/dry ice bath.

 

See �gure in Figures section.

2. Prior to starting this procedure con�rm the plate layout with the supervisor to determine the
location of single cell and 10 cell wells within the 384 well plate.

3. Put a fresh pair of gloves, get fresh ice and keep the ice pan outside of the PCR workstation for
now. Check -20°C freezer \(20-1) to make sure that a chilled Coolrack XT PCR96 and Coolrack M13
are ready. Turn on the PCR machine and place a piece of tape on it to indicate it is in use.

 

4. Put on a new disposable lab coat, turn on the PCR work station and clean the single-cell PCR
space and equipment as per instructions in General Guidelines, section 1.0 above. Wipe down the ice
bucket with RNase or DNA Away before placing it inside the now clean single-cell work station.

 

5. Retrieve one aliquot of 2.5 ng/uL stock of HL60 gDNA from 4°C \(scPBAL Box) and keep it on ice.  

 



Page 10/60

6. Retrieve one aliquot of 6pg/uL of Spike-In mix from the 4°C fridge and keep it on ice. Using LoBind
tube \(labeled as SC spike-in), make 100X dilution by mixing 2 uL of the Spike-In mix with 198 uL of
Ultrapure distilled water \(Invitrogen). This should yield 60fg/uL concentration. Mix very well by
multiple pulse-vortexing. Keep it on ice.

 

7. Inside the PCR work station, working on ice, in a LoBind 1.5mL tube, prepare the Lysis brew
according to the following calculator:
See �gure in Figures section.
8. All reagents \(except enzymes) must be pulse-vortexed and spun down in a minifuge before
addition to the brew. Add enzyme last. Mix enzyme by gently �icking the tube then spin down in a
minifuge before addition to the brew.

 

9. After addition of all of the components, pulse-vortex the brew multiple times to assure an even
distribution of all components. Quick spin the brew in a minifuge and keep it on ice.

 

10. Working on ice, aliquot 40uL/well of the Lysis brew \(4uL X 8 rows + extra) into row A of a fresh
AB 1400L 96-well reservoir plate. Seal the plate with EdgeBio cover and spin down at 3000rpm for
1min, 4°C.   Keep the plate on ice. This plate will be used as a reservoir \(label the plate “RV” and
mark the row).

 

11. Retrieve 384-well single cell sample plate from the -80°C freezer and spin it down for 2 minutes at
3000rpm at 4˚C. Place the plate on ice. Mark the rows and columns that contain samples.

 

 

12. Working on ice, using a P20 multichannel pipette, add 4uL/well of Lysis buffer into each sample
well of the 384-well plate \(according to plate layout – quadrant A only). After each row addition,
pipette up and down 10 times to mix. Try not to create bubbles. Change tips between rows. If there is
a re-arrangement of well locations - note the changes in your lab book.

 

13. Seal the “RV” plate with a EdgeBio cover and save it for later. Seal the 384-well sample plate with
EdgeBio cover and spin down at 3000 rpm, 4°C for 1min.
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14. Working on ice, using P20 multichannel pipette set to 6 uL, transfer all 4 uL from each sample
well into a new LoBind 96-well plate except M1, M3, O1, O3, label this plate “scPBAL DNA”. In the new
LoBind 96-well plate, make sure to leave 4 wells empty for 3 negative controls \(G2, H1 and H2) and
one positive HL60 gDNA control \(G1).

 

15. To the 3 negative control wells: G2, H1, and H2 add 4ul of Lysis buffer \(take the buffer from the
Lysis buffer reservoir plate). Leave G1 well empty.

 

16. Seal the 96-well sample plate with a BioRad PCR cover using MicroAmp adhesive �lm applicator
as follows:

 

16.1. After placing the PCR cover on, using adhesive �lm applicator apply �rm pressure to press the
cover onto the plate.

16.2. Run the applicator �rmly from left to right several times. Run the applicator up and down
several times. Create a good seal around each well.

16.3. Run the edge of the applicator around the border to seal the edge wells.

16.4. Repeat the left to right and up and down motions to assure a good �nal seal.

16.5. Inspect each well to make sure that each well edge is imprinted on the PCR cover.

 

Note: Using the applicator's edge to seal between the wells is NOT recommended. It may actually pull the
seal off the wells.

 

17. Spin the plate at 3000 rpm, 4°C for 1min. Place the plate in a pre-heated to 50°C PCR machine \
(record PCR machine number) and close the lid. Use program: sc-lysis to incubate at 50°C for 30
minutes followed by a 4°C hold \(with heated lid). While the plate is incubating, pre-treat the silica
beads with DNase I \(see step 4 below).

 

18. After the 30min incubation is complete, spin the plate at 3000rpm for 1min at 4°C.
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19. Keep the “scPBAL DNA” plate on ice.   If necessary, store the plate at -20°C overnight as this is a
safe stopping point.

 

 

 

 

 

4. DNase I treatment of silica beads

 

1. Retrieve an aliquot of silica beads from the 4°C fridge \(BOX: MagSi beads).   Gently pulse- vortex
the tube thoroughly until the solution is uniformly dark brown and there is no longer a bead pellet on
the bottom of the vial.

2. Calculate total amount of beads required using the calculator below. For a full plate the volume is
230 uL.

See �gure in Figures section.
 

3. Aliquot the beads equal volume \(115 uL) into 2 wells: B1 and B2 of the “RV” reservoir plate.

 

4. Place the plate on the Magnum FLX magnet \(wipe down the magnet before placing it inside the
hood) and incubate at room temperature for 2 min until the beads separate and the solution
becomes clear.

See �gure in Figures section.
 

5. Using P200, carefully remove the supernatant without disturbing the beads.

 

6. Take the plate off the magnet and resuspend the beads in each well with 115uL of Qiagen EB
buffer. Mix up and down few times.
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7. Place the plate back onto the magnet for 2 min until the solution becomes clear.

 

8. While the beads are on a magnet, working on ice, prepare DNase I master mix according to the
following calculator:

9. All reagents \(except enzymes) must be vortexed and spun down in a minifuge before addition to
the brew.  

10. Add all of the non-enzymatic components �rst and mix very well by repeated pulse-vortexing.  
Keep it on ice.

 

11. Enzyme should be added last. Transport the enzyme from -20°C freezer to the PCR workstation in
a pre-chilled to -20°C Coolrack M13 \(for tubes).

 

12. Mix the enzyme by �icking the tube several time, quick spin in a minifuge, and place it back in the
chilled tube coolrack.

 

13. When pipetting the enzyme, aspirate slowly as the solution is viscous. After dispensing the
enzyme into the brew, pipette up and down several times to rinse the tip.

 

14. Immediately return the enzyme back to the -20°C freezer before proceeding.

 

15. Mix the entire brew very well by gentle pulse-vortexing, spin down in a minifuge and keep it on
ice.

 

16. With the “RV” plate still on the magnet, carefully remove the supernatant. Do not disturb the
beads.

 

17. Remove the plate from the magnet and resuspend each well with beads in 115 uL of DNase I
master mix.   Mix each well very well by pipetting up and down 10 times.
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18. Seal the plate very well with a BioRad PCR cover. Do not spin down.  

 

19. Place the plate in a PCR machine pre-heated to 37°C and close the lid. Use program: sc-dnase1:
37°C for 30 minutes, 70°C for 10 minutes, 4°C hold.

 

20. After DNAse I treatment is complete, remove the plate from the PCR machine and keep it on ice.
Split the mixture equally over one full row and seal the plate with EdgeBio cover. This will be 19 uL
per well.   Note: DNase I treated silica beads can be stored at 4˚C overnight.

 

 

 

5. MethylEdge bisul�te conversion

1. Prepare the MethylEdge Conversion mix using the following calculator:

            

2. Aliquot the Conversion Mix 310uL/well into one row of the “RV” plate. Mark the row.

3. Get the “scPBAL DNA” plate, add the 4 uL \(10ng) HL60 gDNA into the positive control well -G1.

 

4. Using P200 multichannel pipette, add 33.5uL of the Conversion mix prepared above into each row
of the “scPBAL DNA” plate \(except negative control wells) and mix 10 times by pipetting up and
down.   Change tips between rows. Make sure to manually take off the tips corresponding to the 3
negative control wells: G2, H1 and H2. Make sure to add the mix to the positive control well – G1.

 

5. Using P100 single channel pipette, add 33.5uL of MethylEdge Conversion reagent only \(without
the spike-in controls) into the 2 negative control wells: H1 and H2 and mix 10 times by pipetting up
and down.

 

6. Seal the plate with a BioRad PCR �lm and spin it down for 1 minute at 3000 rpm at 4˚C.
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7. Place the plate in a PCR machine, close the lid and incubate using program bs-prg1 \(with a
heated lid):

                 98°C for 8 min

                 54°C for 60 minutes

                 4°C forever

 

8. While the plate is incubating, UV-treat the reagents as outlined in step 6 below.

 

9. After the incubation of bisul�te conversion completes, spin the plate at 3000g for 1min, 4°C and
proceed to the Desulphonation. Keep the plate covered to minimize the exposure to light.

 

�. sc Desulphonation reagent preparation – UV treatment

 

1. Retrieve one tube of NEB 2 buffer from -20°C and place it on ice.

 

2. Prepare Binding buffer + Beads mixture:

 

2.1. Get a new 96well plate and label it “Binding+Beads”.

2.2. Mix the DNase I treated silica beads in the “RV” plate by pipetting up and down at least 10X.

2.3. Using a P20 multichannel, add 2uL of the DNase I treated beads into each well of
“Binding+Beads” plate. No need to change tips between rows. Cover and save the “RV” plate.  

2.4. Pour MethylEdge Binding buffer into a clean reservoir.   Using P200 multichannel, aliquot 180uL
per well into “Binding+Beads” plate. Mix the beads and binding buffer very well by pipetting up and
down at least 10X until it is homogenous light brown. No need to change tips between rows. Make
sure that the solution is fully homogenous before moving forward.

Cover with a plastic seal and keep it at room temperature.
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2.5. Collect the leftover buffer from reservoir back to Binding Buffer bottle.

 

3. Prepare the Desulphonation plate:

 

3.1. Get another new 96well plate and label it “Desul”.

3.2. Pour around 8 mL MethylEdge Desulphonation buffer into a clean reservoir and using P200
multichannel, aliquot 65uL per well into “Desul” plate \(equivalent to the number of reactions). Cover
the plate with a plastic seal and keep it at room temperature.

 

4. Pour Qiagen EB buffer into a clean reservoir and using P200 multichannel, aliquot 30uL per well
into a 96 well plate \(equivalent to the number of reactions). Cover the plate with a plastic seal, label
“EB”, and keep it at room temperature.

 

5. Using sterile 50mL falcon tubes, prepare two tubes of 50mL 80% ethanol \(mix 40mL of 100%
ethanol with 10mL of ultrapure water).   Mix very well.

 

6. Use aluminum foil to cover the inside of the ice box, shiny side up and �lled with ice. Put the
plates, ethanol, and NEB2 buffer in the ice box. Treat all 3 plates: “Binding + Beads”, “Desul”, “EB”, the
tube of NEB 2 buffer, and both 50mL falcon tubes of 80% ethanol in a UV crosslinking machine for a
total of 60min. \(UV crosslink: set to 60 minutes, located at MSL).

 

7. sc Desulphonation reaction and DNA puri�cation

 

1. Turn on the Eppendorf thermomixer and preheat to 56°C by “spinning” at 0 rpm. Place two plate
coolracks at -20˚C door shelf to chill.

 

2. Turn on the Agilent computer and open VWorks software. Wait for the program to �nish   loading.
Press the login button at the top and enter the account information.
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3. Lift the hood sash until it is just aligned with the red arrows.   Turn on the light and the fan.   Turn
on the switch on the right side of the Bravo and wait for a steady blue indicator light.

 

4. Before placing any items inside, wipe down the hood and the Bravo deck with RNAse or DNA
Away.

 

5. Open the PBAL VWorks form: File > Open and select:
C:\VWorksWorkspace\NGS\Forms\PBAL.VWForm.   To be able to see the form you must change the
�le type to “all types” at the bottom right of the window.

 

6. Ensure that the 96 LT head is on the Bravo. Otherwise, refer to the SOP: EGL006_Changing heads
on the Agilent Bravo.

 

7. In the VWorks form, from the ‘select protocol’ drop down menu choose: “Bisulphite Bead Clean Up”.
Enter the number of rows of samples to be processed and protocol-speci�c parameters:

 

Bead = 2 uL

DNA = 37.5 uL

Binding buffer = 180 uL

Desulphonation buffer = 60 uL

Elute = 15 uL

 

8. Place all needed items on the Bravo deck in their appropriate locations:

                            

               Positions 1-3:   new 96-well tip boxes

               Position 4:   coolrack+ 96 well plate \(“Binding + Beads”)
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               Position 5: low volume magnet \(Magnum FLX)

               Position 6: 96 well plate containing bisul�te treated DNA \(“sc-PBAL DNA”).

               Position 7: empty

               Position 8: new 96 well deep-well reservoir \(1 or 2mL)

               Position 9:   Axygen HP reservoir for 80% ethanol \(Deep one)

              

9. Make sure to check if everything is positioned correctly and to remove all covers before starting of
the program.

 

10. At the bottom of the form, hit the Start button. The Bravo will initialize.

 

11. If an error about a plate being detected in the gripper pops up, hit ‘Ignore’. Another error about W
axis will pop up shortly thereafter. Hit ‘Retry’. The Bravo should now begin the protocol.

 

12. Before any tasks begin, VWorks will ask you to con�gure the tip state editor. Pause the protocol,
and go to Tools > Tip State Editor.

 

13. Click the ‘…’ button on the right of the tip box name and change the tip state as necessary to
match the tip box on the deck. Repeat for all tip boxes, and then hit ‘OK’, then ‘Continue’.

 

14. The program will add the DNA to the beads \(Pos6àPos4) and aliquot the ethanol \(Pos9àPos8):

 

14.1. Bravo will retrieve tips from the tip box at Pos3 and transfer the DNA from the “sc-PBAL DNA”
plate at Pos6 to the ‘Binding + Beads’ plate at Pos4 and mix. The tips will then be returned to Pos3.

14.2. Bravo will retrieve tips from the tip box at Pos2 and aliquot ethanol from reservoir \(pos9) into
ethanol plate \(pos8). You will need to pause the program when the tips are hovering above Pos9 to
pour the fresh 80% ethanol into the reservoir. After Bravo aliquot ethanol, the tips will then be
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returned to Pos2.   Pause the program and cover the ethanol plate at Pos8 right after Bravo drop all
the tips into tip box to prevent evaporation.

 

Note: The evaporation in the BSC is very intense and the ethanol concentration is critical to DNA recovery.
Thus, the ethanol cannot be without a cover for any extended period of time.

 

15. Bravo will retrieve tips from the tip box at Pos3 and mix the ‘Beads + Binding’ plate at Pos4
again. The tips will then be returned to Pos3. Wait until the tips are returned before covering the
‘Beads + Binding’ plate.

 

16. Bravo will then incubate the DNA with the beads for another 8 minutes \(total 10 min).

 

17. After incubation, Bravo will prompt you to move the ‘Beads + Binding’ plate from Pos4 to the
magnet at Pos5.

 

17.1. Before clicking ‘Continue’, place the plate on the magnet at Pos5 and incubate for two minutes
\(set a timer).

17.2. Click ‘Continue’ and the Bravo will incubate the plate on the magnet for 3.5 minutes set.

 

Note: This solution is very viscous and this additional time is necessary to allow all of the beads to settle
on the magnet. This will help ensure we recover as much DNA as possible.

 

18. Next, Bravo will prompt you to remove the reservoir from the Pos9 and replace it with a 96 well
deep-well reservoir \(Waste), and to remove the DNA plate from Pos6 and replace it with the 
UV-treated Desulphonation buffer plate.

 

19. Next, Bravo will remove the binding and lysis buffer from DNA Plate \(Pos5):

19.1. Bravo will retrieve tips from the tip box at Pos3 and remove all of the liquid from the DNA
plate \(‘Binding + Beads’ plate) at Pos5. Pause the protocol when Bravo hovers above Pos5 and
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uncover the plate.   The tips will then be returned to Pos3.  

 

Note: Be sure to check that all of the liquid has been aspirated as the ethanol percentage is critical in the
subsequent steps.

 

20. Next, Bravo will perform two 80% ethanol washes and add desulphonation buffer:

 

20.1. Bravo will retrieve tips from the tip box at Pos2 and then aspirate 80% ethanol from Pos8.  
Pause the protocol when the Bravo machine hovers above Pos8 to remove the cover on the ethanol
plate \(Pos8).

20.2. The ethanol will be gently dispensed into the DNA plate \(Pos5).

20.3. Bravo will let the ethanol solution and the beads incubate for 30 seconds before aspirating all
of the liquid from the wells \(Pos5) and dispensing the waste �uid at Pos9.

20.4. Bravo will then perform a second identical ethanol wash.

20.5. After the waste from the 2nd ethanol wash is dispensed at Pos9, pause the protocol when the
Bravo hovers above the desulphonation plate \(Pos6). Remove the desulphonation plate cover \
(Pos6) and cover the ethanol plate \(Pos8).

20.6. Bravo will retrieve 60uL of desulphonation buffer from Pos6 and dispense it into the DNA plate
at Pos5. The tips will then be returned to Pos2.

 

21. Bravo will incubate the DNA with the desulphonation buffer for 15 minutes. 
Cover the DNA plate \(Pos5).

 

22. After the 15 minutes incubation, Bravo will prompt with a pop-up message. Follow the
instructions and remove the plate cover on Pos5 before clicking ‘Continue’.

 

23. Bravo will discard the waste �uid and perform two ethanol washes:

 

23.1. Bravo will retrieve tips from the tip box at Pos2 and then aspirate the used desulphonation
buffer from Pos5 and discard the waste �uid at Pos9.
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23.2. Bravo will then aspirate 80% ethanol from Pos8 to perform the �rst wash. Pause the protocol
when the Bravo machine hovers above Pos8 to remove the cover on the ethanol plate \(Pos8).

23.3. The ethanol will be gently dispensed onto the DNA plate \(Pos5).

23.4. Bravo will let the ethanol solution and the beads incubate for 30 seconds before aspirating all
of the liquid from the wells \(Pos5) and dispensing the waste �uid at Pos9.

23.5. Bravo will then perform a second identical ethanol wash.

23.6. After the waste from the 2nd ethanol wash is discarded, let the DNA plate dry for one minute
uncovered \(start a timer for one minute). The tips will then be returned to Pos2.

23.7. Cover the DNA plate \(Pos5) when the timer alarm goes off and let the DNA dry \(covered) for
two additional minutes.

 

24. While the beads are drying, replace the plate at Pos6 with your UV-treated QEB plate.

 

25. After two minutes, Bravo will prompt you with a pop-up message. Remove the cover on the QEB
plate \(Pos6) before clicking ‘Continue’.

 

26. Bravo will then add 15uL of QEB \(Pos6) to your DNA plate \(Pos4):

26.1. Bravo will retrieve tips from the tip box at Pos1 and aspirate 15uL of QEB from Pos6.

26.2. Pause the protocol when the Bravo hovers above Pos4 to dispense the QEB. Remove the
cover from the DNA plate and move the plate from Pos5àPos4.

26.3. Bravo will dispense the QEB into the DNA plate at Pos4 and mix to resuspend the beads.

 

27. After the beads are re-suspended in EB buffer, cover the plate with a BioRad PCR cover and place
the plate in the Eppendorf thermomixer at 56˚C for 15 minutes at 2000 rpm \(according to pop-up
message). Tape the plate down to the incubator to prevent the plate from �ying off.

 

27.1. Set a timer for �ve minutes and when the alarm goes off, brie�y turn the thermomixer down to
1700 rpm to allow the liquid near to the top of the vortex to reincorporate into the larger volume.
Then turn the thermomixer back up to 2000 rpm.

27.2. Set another timer for �ve minutes and repeat.
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28. While the plate is incubating start preparation for 1st DNA synthesis.

 

�. sc 1st DNA Synthesis

 

1. Retrieve reagents needed for 1st DNA synthesis \(except enzymes) from -20° C freezer, thaw them
and place them on ice.

2. Working on ice, prepare the DNA denaturation mix according to the following calculator:

 

 

3. Mix the pre-denaturation mix very well by repeated pulse-vortexing, spin down in a minifuge, and
keep it on ice.

 

4. Aliquot 72uL of the mix into one 12-well strip tube \(7.25 uL**8rows+14uLdead volume=72uL).

 

5. Change the tip box at position 2 on Bravo.

 

6. Pause the program and update the tip editor with Box-position2.

 

7. Place the master mix strip-tube on row A of a chilled cool-rack at position 7 on Bravo.

8. Aliquot 7.25uL of pre-denaturation mix into each will of a new LoBind plate. Place this plate on a
chilled cool-rack at position 6 on Bravo.

 

9. After the 56°C incubation is complete, place the “Binding + Beads” plate in a thermocycler and
close the hot lid. Keep it in for 5 seconds to remove any condensation on the tape pad. If there is any
droplet on the side of the wells, spin the plate down shortly for 3~4 sec.

 

10. Place the “Binding + Beads” plate back on the Bravo deck: on top of the magnet in position 5.  
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11. The robot will �rst aliquot the master mix brew from the 12-well strip tube into the new LoBind
plate 7.25 uL/well at position 6. Then it will transfer the elute DNA 15 uL/well into the brew plate and
mix.

 

12. After the program completes, seal the plate with BioRad PCR cover and spin down the “scPBAL
PR” plate for 1 minute at 4˚C at 3000 rpm.

 

13. Incubate the “scPBAL PR” plate at 98°C for 1 minute in a thermocycler and immediately spin
down the plate at 3000 rpm for 1 minutes at 4˚C. Place this plate on ice, keep it COLD.

 

14. Working on ice, prepare post-denaturation mix according to the following calculator:

 

 

 

15. Vortex the buffer before addition to the brew.

 

16. Remove the enzyme from -20°C freezer and place it in the chilled tube coolrack for transport to
the PCR workstation.

 

17. Mix the enzyme by �icking the tube, spin down in a minifuge, and place it back in the chilled tube
coolrack.

 

18. When you pipette the enzyme, aspirate slowly. After dispensing the enzyme into the brew, wash
the tip by pipetting up and down. Place the brew back on ice. Return the enzyme back into the -20°C
freezer before proceeding.
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19. Mix the brew very well by multiple pulse-vortexing and keep it on ice.

 

20. Aliquot 27uL per well of the post-denaturation mix into a row of the “RV” plate. Cover and if
necessary spin the plate down at 3000rpm for 1min, 4°C to collect the liquid on the bottom. Place
this plate in a -20˚C chilled coolracks.

 

21. Place the “scPBAL RP” plate on the other -20˚C chilled plate coolrack.

 

22. Using P20 multichannel, add 3uL per well of the post-denaturation mix into each row of the
“scPBAL RP” plate. After each row addition, set P20 multichannel to 10uL, mix each row up and
down 10 times. Change tips between rows.

 

23. After mixing of the last row, seal the plate with BioRad PCR cover, spin the plate down at 3000
rpm, 4°C for 1min.

24. Place the plate in the thermocycler, close the lid and run the program pbat-rand-a:

 

4°C for 10 minutes

4°C to 37°C ramping at 4°C/minute

37°C for 30 minutes

98°C for 1 minutes

4˚C forever

 

25. Place the coolracks back in the -20°C freezer to chill for the next step.

 

9. sc 2nd DNA synthesis
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1. About 15 minutes before the program is �nished start preparing for the second round of random
priming.  

2. Working on ice, prepare 2nd DNA synthesis mix according to the following calculator:

 

3. All reagents \(except enzymes) must be pulse-vortexed and spin down in a minifuge before
addition to the brew. Enzymes should be added last.

 

4. When ready to add the enzyme, pulse-vortex the brew multiple times, then spin down in a minifuge,
and place back on ice.

 

5. Remove the Klenow exo – \(50U/uL) from -20°C freezer and place it in the chilled tube cool rack
for transport to the PCR workstation.  

 

 

6. Mix each enzyme by �icking the tube, then spin down in a minifuge and place it back in the chilled
tube cool rack.

 

7. When pipetting the enzyme, aspirate slowly to assure an accurate volume transfer. Enzyme
storage buffers contain glycerol, which makes the solution more viscous than water.

 

8. After dispensing the enzyme into the brew, wash the tip by pipetting up and down.   After enzyme
addition, place the brew immediately back on ice. Return the enzyme back into the -20°C freezer
before proceeding.

 

9. Mix the entire 2nd DNA synthesis mix very well by multiple pulse-vortexing, spin down in a
minifuge and place it back on ice.
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10. Once the pbat-rand program is �nished, immediately spin down the “scPBAL RP” plate for 2
minutes at 4˚C at 3000 rpm. Place the plate on ice.

 

11. Aliquot 45uL/well of the prepared mix into row F of “RV” plate.   Cover and keep it on ice. If
needed, spin down for 1min at 3000 rpm at 4˚C. Place this plate in a -20˚C chilled coolrack.

 

12. Place the “scPBAL RP” plate on another -20˚C chilled coolrack.

 

13. Using a P20 multichannel, add 5 uL per well of the 2nd DNA synthesis mix to each row of the
“scPBAL RP” plate. After each addition, set the multichannel to 15 uL and mix up and down at least
10X, lifting your pipet when dispensing and aspirating from the bottom of the well. Change tips
between rows.

 

14. Seal the plate with a BioRad PCR cover and spin down for 1 minute at 4˚C at 3000 rpm.

 

15. Place the plate in the thermocycler, close the lid, and run the program pbat-rand-b:

 

4°C for 30 seconds

4°C to 37°C ramping at 1°C/15 seconds

37°C for 30 minutes

70°C for 10 minutes

4˚C forever

16. After the program �nishes, spin down the plate at 3000 rpm for 1min at 4˚C.

 

17. In hood, change the PCR cover to Aluminum Cover. Seal and label with name and date, and store
at -20˚C overnight.
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Clean up your workstation. Remove garbage. This concludes Day 1 of this protocol.

DAY 2

 

10. SeraMag Bead Cleanup \(BCU) and End Repair/Phosphorylation

 

1. Pre-chill two coolracks at -20˚C. Put on a new disposable lab coat, clean workstation and Bravo.

 

2. Take out 20% PEG SeraMag beads from 4°C \(6 ml is required for one full 96-well plate). Mix by
vortexing and leave them to warm at room temperature for at least 30 minutes.

 

3. Ensure that the correct 96 LT head is on the Bravo.

 

4. Turn on the Bravo computer and open VWorks. Wait for the program to �nish loading. Press the
login button at the top and enter your account information.

 

5. Lift the hood sash until it is just above the red arrows.   Turn on the light and the fan.   Turn on the
switch on the right side of the Agilent Bravo and wait for a steady blue indicator light.

 

6. Clean the Bravo deck with RNase or DNA Away.

 

7. Prepare 50mL of 70% ethanol \(mix 35mL of 100% ethanol with 15mL of ultrapure water).

 

8. Pour Qiagen EB buffer into a clean reservoir. Aliquot 100 uL of EB buffer into each well of a new
AB1400 plate. Label this plate the “EB” plate.
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9. Retrieve “scPBAL RP” plate from -20˚C. Spin down at 3000 rpm for 1min, 4°C.

 

10. Measure the volume of three random DNA wells \(should be 30 uL, but may be less due to
evaporation) and using P20 multichannel add su�cient EB \(usually 21-24 uL) to reach 50 uL/well.
After each row addition, mix well by pipetting up and down 10X.   Change tips between rows.

 

                 Note: It is better to have >50 uL than to have <50 uL in this step.

 

11. Make sure that the DNA/reaction plate is spun down at 3000rpm for 1min, 4°C before placing it
on the Bravo deck.

 

12. Once SeraMag beads reach room temperature, aliquot them into one row of a 450uL Axygen
plate.

 

13. Using P200 multichannel, aliquot 55 uL of beads into each well of a new AB1400 plate. Label
this plate the “beads”.   If there are beads on the side of the well, short spin of 4-5 seconds is allowed.
Do not spin down beyond that.

 

14. Open the PBAL form. File > Open and select: C:\VWorks Workspace\NGS\Forms\PBAL.VWForm.
To be able to see the form you must change the �le type at the bottom right of the window.

 

15. In the form, from the ‘select protocol’ drop down list choose “Ampure XP Bead Cleanup-tony”. Hit
the ‘Display Initial Setup’ button on the form.

 

16. Set up the deck on the Bravo deck according to the setup diagram on the screen which should
match the image below:

            

             Positions 1-3: New 96-well tip boxes \(full plate of tips)
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             Position 4: Coolrack + “DNA” plate \(make sure the plate us spun down)

             Position 5: low volume magnet \(Magnum FLX)

             Position 6: Coolrack + “beads” plate

             Position 7: empty

              Position 8: 96 well 450V reservoir

             Position 9:   Axygen LP reservoir for 70% ethanol

 

17. Enter the number of rows to be processed \(8 for a full plate) and set the variables as follows:

 

                     DNA volume = 50 uL

                   Bead volume = 50 uL

                   Elution volume = 35 uL

 

 

Ethanol volume = 150 uL

 

 

18. Check the Bravo deck if all of the items are present and placed correctly. Make sure that all of the
covers have been removed from plates and tip boxes before proceeding.

 

19. At the bottom of the NGS form, hit the Start button. The Bravo will initialize. If an error about a
plate being detected in the gripper pops up, hit ‘Ignore’. Another error will pop up shortly thereafter. Hit
‘Retry’. The Bravo should now begin the protocol.
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20. Before any tasks begin, VWorks will ask you to con�gure the tip state editor. Pause the protocol,
and go to Tools > Tip State Editor.

 

21. Click the ‘…’ button on the right of the tip box name and change the tip state to match the tip box
on the deck. Repeat for all tip boxes then hit ‘OK’ and ‘Continue’.

 

Note: While the protocol is being executed watch the Bravo to make sure that all volumes are being
correctly pipetted. For example, there should be no empty space in the tips when beads are being added
to the DNA.

 

22. The program will add the beads \(Pos6) to the DNA plate \(Pos4).   Bravo will retrieve tips from
Pos3 and transfer 50uL of beads from Pos6 to the DNA plate at Pos4 and mix. The tips will then be
returned to Pos3.

 

23. After bead addition, during the incubation, pause the protocol and cover the DNA plate with a
plastic cover.

 

24. The program will aliquot the ethanol into the 96 well reservoir \(Pos9àPos8)

 

24.1. Bravo will retrieve tips from the tip box at Pos2 and aliquot ethanol from the reservoir \(Pos9)
into the ethanol plate \(Pos8).   Pause the program when the machine hovers above Pos9 to pour the
fresh 70% Ethanol into the reservoir. The tips will be returned to Pos2 after the last of the ethanol is
aliquoted.

24.2. After ethanol aliquoting, pause the program and cover the ethanol plate at Pos8.

 

25. The program will then incubate the DNA plate with the beads for 8 minutes \(10 minutes total).

 

26. After incubation, the program will prompt you to put the plate on the magnet and replace the
ethanol reservoir from Pos9 with an empty Axygen 450 waste plate.
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26.1. Place the plate on the magnet at Pos5 and incubate for 5 minutes.

 

Note: Check the walls of the wells to ensure that all of the liquid is at the bottom of the well before
placing the plate on the magnet. Spin for 3-4s in the centrifuge if this condition is not met.

 

27. Next, Bravo will remove the waste �uid from the DNA plate \(Pos5).

 

27.1. Bravo will retrieve tips from the tip box at Pos3 and proceed to remove all of the liquid from the
DNA plate at Pos5. Pause the protocol when Bravo hovers above Pos5 and uncover the plate.

27.2. Bravo will dispense the waste �uid at Pos9. The tips will then be returned to Pos3.

 

28. Next, Bravo will perform two 70% ethanol washes.

28.1. Bravo will retrieve tips from the tip box at Pos2 and then aspirate 70% ethanol from Pos8.
Pause the protocol when the Bravo machine hovers above Pos8 to remove the cover on the
ethanol plate \(Pos8).

28.2. The ethanol will be gently dispensed into the DNA plate \(Pos5).

28.3. Bravo will let the ethanol solution and the beads incubate for 30 seconds before aspirating
all of the liquid from the wells \(Pos5) and dispensing the waste �uid at Pos9.

28.4. Bravo will then perform a second identical ethanol wash.

28.5. After the waste from the 2nd ethanol wash is dispensed at Pos9, set a timer for one minute.
The tips will then be returned to Pos2.

 

29. When the timer alarms, cover the plate \(Pos5) and let the plate dry for two additional minutes.

 

Note: Before continuing, inspect the reaction plate to make sure that all of the traces of ethanol are
evaporated. The beads should be completely dry but not cracked. Make sure the beads are not over-dried
as that reduces DNA recovery.
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30. Next, Bravo will prompt you to move the DNA plate from Pos5 to Pos4 and to place the QEB plate
at Pos6. Do not move the DNA plate yet, but place the QEB plate at Pos6. Remove the cover on the
QEB plate and click ‘Continue’.

 

31. The program will then add 35 uL QEB \(Pos6) to the DNA plate \(Pos4) and incubate for a
minimum of four minutes.

 

31.1. Bravo will retrieve tips from the tip box at Pos1 and aspirate QEB from Pos6.

31.2. Bravo will then dispense the QEB into the DNA plate at Pos4.   Pause the protocol when the
machine hovers above Pos4. Uncover the DNA plate \(Pos5) and move it to Pos4.

31.3. The tips will then be returned to Pos1.

31.4. Cover the DNA plate \(Pos4) when the machine is no longer in motion.

 

32. After the EB buffer has been added and mixed with dried beads pause the program and in a
2.0mL tube prepare the End-repair master mix according to the following calculator:

                                                           

33. All reagents \(except enzymes) must be pulse-vortexed and spin down in a minifuge before
addition to the brew.   Enzymes should be added last.   When ready to add the enzymes, pulse-vortex
the end repair master mix multiple times, then spin down in a minifuge, and place back on ice.

 

34. Remove the enzymes from -20°C freezer and place them in the chilled tube cool rack for transport
to the PCR workstation. Mix each enzyme by �icking the tube, then spin down in a minifuge and
place it back in the chilled tube cool rack.

 

35. When pipetting the enzyme, aspirate slowly to assure an accurate volume transfer. Enzyme
storage buffers contain glycerol, which makes the solution more viscous than water. After dispensing
the enzyme into the brew, wash the tip by pipetting up and down.

 

Note: Never double dip into the solution with the same tip.
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36. After enzyme addition place the brew immediately back on ice. Return the enzymes back into the
-20°C freezer before proceeding.

 

37. Gently pulse-vortex the brew multiple times to assure an even distribution of all of the
components. Pulse-vortexing means that you stop vortexing every time a full vortex is formed in the
tube. Spin down the brew in a minifuge and immediately place it back on ice.

 

38. Working on ice, aliquot 143 uL of the mix into one 12-well strip tube.

 

39. Change the tip box at position 2 on Bravo and pause the program and update the tip editor with
Box-position2.

 

40. Place the master mix strip-tube on row A of a chilled cool-rack at position 7 on Bravo. Place the
elution plate back on the Bravo deck: on top of the magnet in Pos5.  

 

41. The robot will �rst aliquot the master mix brew from the 12-well strip tube into the new LoBind
plate 15 uL/well at position 6. Bravo will transfer \(Pos5) the DNA elution into the brew plate \(Pos6)
and mix.

 

42. After the program completes, cover the plate and spin down the plate for 1 minute at 4˚C at 3000
rpm.

 

43. Incubate at room temperature for 30 minutes then proceed to the next step.
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11. Bead Cleanup and A-Tailing

 

1. Set up the Bravo exactly as stated in Bead Clean-up step 10 except with the following change in
the parameters:

 

                                     DNA volume = 50 uL

                                     Bead volume = 50 uL

       Elution volume = 25 uL

       Ethanol volume = 150 uL

 

2. Make sure that the DNA/reaction plate is spun down at 3000rpm for 1min, 4C before placing it on
the Bravo deck.

 

3. Aliquot SeraMag beads into one row of a 450uL Axygen plate.  

 

4. Using P200 multichannel, aliquot 55 uL of beads into each row of a “beads” plate. If there are
beads on the side of the well, short spin of 4-5 seconds is allowed.

 

5. Check the Bravo deck if all of the items are present and placed correctly. Make sure that all of the
covers have been removed from plates and tip boxes before proceeding.
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6. Start the protocol. Before any tasks begin, VWorks will ask you to con�gure the tip state editor.
Pause the protocol, and go to Tools > Tip State Editor.

 

7. Click the ‘…’ button on the right of the tip box name and change the tip state to match the tip box
on the deck. Repeat for all tip boxes then hit ‘OK’ and ‘Continue’.

 

Note: While the protocol is being executed watch the Bravo to make sure that all volumes are being
correctly pipetted. For example, there should be no empty space in the tips when beads are being added
to the DNA.

 

8. The program will add the beads \(Pos6) to the DNA plate \(Pos4).

 

8.1. Bravo will retrieve tips from Pos3 and transfer 50uL of beads from Pos6 to the DNA plate at
Pos4 and mix. The tips will then be returned to Pos3.

8.2. Pause the protocol and cover the DNA plate.

 

9. The program will aliquot the ethanol into the 96 well reservoir \(Pos9àPos8)

9.1. Bravo will retrieve tips from the tip box at Pos2 and aliquot ethanol from the reservoir \
(Pos9) into the ethanol plate \(Pos8).   Pause the program when the machine hovers above
Pos9 to pour the fresh 70% Ethanol into the reservoir. The tips will be returned to Pos2 after the
last of the ethanol is aliquoted.

9.2. Pause the program and cover the ethanol plate at Pos8.

 

10. The program will then incubate the DNA plate with the beads for 8 minutes \(10 minutes total).

 

11. After incubation, the program will prompt you to put the plate on the magnet and replace the
ethanol reservoir from Pos9 with an empty Axygen 450 waste plate.

 

11.1. Place the plate on the magnet at Pos5 and incubate for two minutes \(set a timer).
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11.2. Click ‘Continue’ when the timer alarms and incubate for an additional 3.5 minutes.

 

Note: Check the walls of the wells to ensure that all of the liquid is at the bottom of the well before
placing the plate on the magnet.   Spin for 3-4s in the centrifuge if this condition is not met.

12. Next, Bravo will remove the waste �uid from the DNA plate \(Pos5).

 

12.1. Bravo will retrieve tips from the tip box at Pos3 and proceed to remove all of the liquid from the
DNA plate at Pos5. Pause the protocol when Bravo hovers above Pos5 and uncover the plate.

12.2. Bravo will dispense the waste �uid at Pos9. The tips will then be returned to Pos3.

 

13. Next, Bravo will perform two 70% ethanol washes.

 

13.1. Bravo will retrieve tips from the tip box at Pos2 and then aspirate 70% ethanol from Pos8.
Pause the protocol when the Bravo machine hovers above Pos8 to remove the cover on the ethanol
plate \(Pos8).

13.2. The ethanol will be gently dispensed into the DNA plate \(Pos5).

13.3. Bravo will let the ethanol solution and the beads incubate for 30 seconds before aspirating all
of the liquid from the wells \(Pos5) and dispensing the waste �uid at Pos9.

13.4. Bravo will then perform a second identical ethanol wash.

13.5. After the waste from the 2nd ethanol wash is dispensed at Pos9, set a timer for one minute. The
tips will then be returned to Pos2.

 

14. When the timer alarms, cover the plate \(Pos5) and let the plate dry for two additional minutes.

 

Note: Before continuing, inspect the reaction plate to make sure that all of the traces of ethanol are
evaporated. The beads should be completely dry but not cracked. Make sure the beads are not over-dried
as that reduces DNA recovery.
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15. Next, Bravo will prompt you to move the DNA plate from Pos5 to Pos4 and to place the QEB plate
at Pos6. Do not move the DNA plate yet, but place the QEB plate at Pos6. Remove the cover on the
QEB plate and click ‘Continue’.

 

16. The program will then add 25 uL QEB \(Pos6) to the DNA plate \(Pos4) and incubate for a
minimum of four minutes.

 

16.1. Bravo will retrieve tips from the tip box at Pos1 and aspirate QEB from Pos6.

16.2. Bravo will then dispense the QEB into the DNA plate at Pos4.   Pause the protocol when the
machine hovers above Pos4. Uncover the DNA plate \(Pos5) and move it to Pos4.

16.3. The tips will then be returned to Pos1.

16.4. Cover the DNA plate \(Pos4) when the machine is no longer in motion.

 

17. After the EB buffer has been added and mixed with dried beads, in a 1.5mL tube prepare A-
addition brew according to the following calculator:

              

18. Aliquot 95 uL of the mix into one 12-well strip tube.

 

19. Change the tip box at position 2 on Bravo. Pause the program and update the tip editor with Box-
position2.

 

20. Place the master mix strip-tube on row A of a chilled cool-rack at position 7 on Bravo. Place a
LoBind plate on a chilled cool-rack at position 6 on Bravo.

 

21. Place the elution plate back on the Bravo deck: on top of the magnet in position 5.  

 

22. The robot will �rst aliquot the master mix brew from the 12-well strip tube into the new LoBind
plate 10 uL/well at position 6. Then it will transfer \(Pos5) the elute DNA 25 uL/well into the brew
plate \(Pos6) and mix.
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23. After the program completes, seal the plate with a BioRad PCR cover and spin down the “A-
addition” plate at 4˚C at 3000 rpm for 1 minute.

 

24. Incubate the �nal reaction \(35 uL total volume) at 37˚C for 30 minutes and then inactivate at
70˚C for 10 minutes.

 

Note: Do not cover with the Thermocycler lid. Loosely cover with Thermomixer lid.

 

25. While waiting, prepare for the next step.

 

 

 

12. sc PBAL direct ligation

 

1. Retrieve the 5X Quick Ligation Buffer from -20˚C and thaw at room temperature then transfer to
ice. Mix very well before use. This reagent contains high concentration of PEG, which makes it more
di�cult to pipette. Take an extra care to pipette this reagent slowly to assure accuracy of volume
transfer.

 

2. Retrieve one plate single use aliquot of 10 uM PE Adapter. Prepare 300uL of 1 uM Adapter \(1/10
dilution, 30 uL stock + 270uL EB) by diluting with EB buffer. Aliquot the diluted 1 uM adapter into one
row of a 96-well plate, 24uL/well.   Cover the plate and keep it on ice.

 

3. Prepare the ligation brew in one 5 mL tube according to the following calculator:
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4. All reagents \(except enzymes) must be pulse-vortexed and spin down in a minifuge before
addition to the brew.   Enzymes should be added last.   When ready to add the enzymes, pulse-vortex
the end repair master mix multiple times, then spin down in a minifuge, and place back on ice.

 

5. Remove the enzymes from -20°C freezer and place them in the chilled tube cool rack for transport
to the PCR workstation.   Mix each enzyme by �icking the tube, then spin down in a minifuge and
place it back in the chilled tube cool rack.

 

6. When pipetting the enzyme, aspirate slowly to assure an accurate volume transfer. Enzyme
storage buffers contain glycerol, which makes the solution more viscous than water.

 

7. After dispensing the enzyme into the brew, wash the tip by pipetting up and down. Do not double
dip with the same tip into a stock solution. After enzyme addition, place the brew immediately back
on ice.

 

8. Return the enzymes back into the -20°C freezer before proceeding.

 

 

9. Gently pulse vortex the brew multiple times to assure an even distribution of all of the
components. Pulse vortexing means that you stop vortexing every time a full vortex is formed in the
tube. Brie�y spin down the brew in a minifuge and place it back on ice.

 

10. Aliquot 200 uL of the mix into one 12-well strip tube.

 

11. Change the tip box at position 2 on Bravo. Pause the program and update the tip editor with Box-
position2.

 

12. Place the master mix strip-tube on row A of a chilled cool-rack at position 7 on Bravo.
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13. Place the elution plate back on the Bravo deck: on top of the magnet in position 5.  

 

14. Manually add 2 uL adaptor from the reservoir row to each well of new LoBind plate using P20
multichannel pipette.   Label the plate “PBAL Ligation”. Place the plate on a chilled cool-rack at
position 6 on Bravo.

 

15. The robot will �rst aliquot the master mix brew from the 12-well strip tube into the new LoBind
plate 23 uL/well at position 6. Click ‘Continue’ and Bravo will transfer \(Pos5) the DNA elution 35
uL/well into the brew plate \(Pos6) and mix.

 

16. Once the program �nishes, cover the ‘PBAL Ligation’ plate at Pos6 and move it to the laminar
�ow hood.   Add 23 uL of the ligation master mix into each well via P200 multichannel pipette.

 

17. Use the P200 multichannel pipette to mix. Set the pipette to 40 uL and then aspirate the reaction
mixture from the bottom of each well and slightly lift the tip of the pipette before dispensing on the
top. Repeat this ten times to ensure thorough mixing.

 

Note: Pipet slowly to avoid bubbles.

 

18. Cover the plate with an aluminum cover, and spin down at 3000rpm for 1min at 4C.

 

19. Incubate the “PBAL Ligation” plate at room temperature overnight. Label the date and sample
name clearly.

 

20. Clean up your single cell PCR work-station and Bravo. Turn off all of the used equipment.
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21. Enter all of the data in your laboratory notebook. This concludes Day 2 of this protocol.

 

Clean up your workstation. Remove garbage. This concludes Day 2 of this protocol.

 

 

 

DAY 3

13. 1st Bead Cleanup After Ligation

 

1. Take out 20% PEG SeraMag beads from 4°C \(enough for one full 96-well beads clean-up will be 6
tubes), mix by vortexing and leave them to warm at room temperature for at least 30 minutes. Before
proceeding make sure that the SeraMag bead solution fully reached room temperature. Using a cold
solution results in reduced DNA recovery.

 

2. Aliquot 55 uL of beads into each well of a new plate. Label this plate the “beads” plate. Do NOT
use a reservoir for this step as the beads will settle and the PEG concentration will not be consistent.

 

3. Aliquot 120 uL of EB buffer into each well of a new plate. Label this plate the “EB” plate.

 

4. Set up the bravo exactly as stated in Bead-Cleanup and End-Repair \(step 10) except with the
following parameters:

 

                         DNA volume = 60 uL

                         Bead volume = 48 uL

Elution volume = 50 uL
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5. The program will add the beads \(Pos6) to the DNA plate \(Pos4).

5.1. Bravo will retrieve tips from Pos3 and transfer 50uL of beads from Pos6 to the DNA plate at
Pos4 and mix. The tips will then be returned to Pos3.

5.2. Pause the protocol and cover the DNA plate.

 

6. The program will aliquot the ethanol into the 96 well reservoir \(Pos9àPos8)

6.1. Bravo will retrieve tips from the tip box at Pos2 and aliquot ethanol from the reservoir \
(Pos9) into the ethanol plate \(Pos8). Pause the program when the machine hovers above Pos9
to pour the fresh 70% Ethanol into the reservoir. The tips will be returned to Pos2 after the last of
the ethanol is aliquoted.

6.2. Pause the program and cover the ethanol plate at Pos8.

 

7. The program will then incubate the DNA plate with the beads for 8 minutes \(10 minutes total).

 

8. After incubation, the program will prompt you to put the plate on the magnet and replace the
ethanol reservoir from Pos9 with an empty Axygen 450 waste plate.

 

8.1. Place the plate on the magnet at Pos5 and incubate for two minutes \(set a timer).  

8.2. Click ‘Continue’ when the timer alarms and incubate for an additional 3.5 minutes.

 

Note: Check the walls of the wells to ensure that all of the liquid is at the bottom of the well before
placing the plate on the magnet.   Spin for 3-4s in the centrifuge if this condition is not met.

 

9. Next, Bravo will remove the waste �uid from the DNA plate \(Pos5).

9.1. Bravo will retrieve tips from the tip box at Pos3 and proceed to remove all of the liquid from
the DNA plate at Pos5. Pause the protocol when Bravo hovers above Pos5 and uncover the
plate.

9.2. Bravo will dispense the waste �uid at Pos9.   The tips will then be returned to Pos3.

10. Next, Bravo will perform two 70% ethanol washes.
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10.1. Bravo will retrieve tips from the tip box at Pos2 and then aspirate 70% ethanol from Pos8.
Pause the protocol when the Bravo machine hovers above Pos8 to remove the cover on the
ethanol plate \(Pos8).

10.2. The ethanol will be gently dispensed into the DNA plate \(Pos5).

10.3. Bravo will let the ethanol solution and the beads incubate for 30 seconds before aspirating
all of the liquid from the wells \(Pos5) and dispensing the waste �uid at Pos9.

10.4. Bravo will then perform a second identical ethanol wash.

10.5. After the waste from the 2nd ethanol wash is dispensed at Pos9, set a timer for one minute.
The tips will then be returned to Pos2.

 

11. When the timer alarms, cover the plate \(Pos5) and let the plate dry for two additional minutes.

 

Note: Before continuing, inspect the reaction plate to make sure that all of the traces of ethanol are
evaporated. The beads should be completely dry but not cracked. Make sure the beads are not over-dried
as that reduces DNA recovery.

 

12. Next, Bravo will prompt you to move the DNA plate from Pos5 to Pos4 and to place the QEB plate
at Pos6. Do not move the DNA plate yet, but place the QEB plate at Pos6. Remove the cover on the
QEB plate and click ‘Continue’.

 

13. The program will then add 50 uL QEB \(Pos6) to the DNA plate \(Pos4) and incubate for a
minimum of four minutes.

 

13.1. Bravo will retrieve tips from the tip box at Pos1 and aspirate QEB from Pos6.

13.2. Bravo will then dispense the QEB into the DNA plate at Pos4.   Pause the protocol when the
machine hovers above Pos4. Uncover the DNA plate \(Pos5) and move it to Pos4.

13.3. The tips will then be returned to Pos1.

13.4. Cover the DNA plate \(Pos4) when the machine is no longer in motion.

 

14. Place a new LoBind plate at Pos6. Bravo should elute the supernatant directly into new plate.
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15. Take the �nal eluted product and use it as the input DNA for the next step.

 

14. 2nd Bead cleanup after ligation and PCR ampli�cation of library

 

1. Aliquot 55 uL of beads into each well of the “beads” plate. Do NOT use a reservoir for this step as
the beads will settle and the PEG concentration will not be consistent.

 

2. Set up the Bravo exactly as stated in Bead-Cleanup and End-Repair \(step 10) except with the
following parameters:

 

                           DNA volume = 50 uL

                           Bead volume = 50 uL

Elution volume = 25 uL

 

3. Start the protocol. Replace the “beads” plate with the “EB” plate after the beads have been added
to the DNA plate.

4. The program will add the beads \(Pos6) to the DNA plate \(Pos4).

4.1. Bravo will retrieve tips from Pos3 and transfer 50uL of beads from Pos6 to the DNA plate at
Pos4 and mix. The tips will then be returned to Pos3.

4.2. Pause the protocol and cover the DNA plate.

 

5. The program will aliquot the ethanol into the 96 well reservoir \(Pos9àPos8)

 

5.1. Bravo will retrieve tips from the tip box at Pos2 and aliquot ethanol from the reservoir \(Pos9)
into the ethanol plate \(Pos8). Pause the program when the machine hovers above Pos9 to pour the
fresh 70% Ethanol into the reservoir. The tips will be returned to Pos2 after the last of the ethanol is
aliquoted.
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5.2. Pause the program and cover the ethanol plate at Pos8.

 

6. The program will then incubate the DNA plate with the beads for 8 minutes \(10 minutes total).\

 

7. After incubation, the program will prompt you to put the plate on the magnet and replace the
ethanol reservoir from Pos9 with an empty Axygen 450 waste plate.

 

7.1. Place the plate on the magnet at Pos5 and incubate for two minutes \(set a timer).

7.2. Click ‘Continue’ when the timer alarms and incubate for an additional 3.5 minutes.

 

Note: Check the walls of the wells to ensure that all of the liquid is at the bottom of the well before
placing the plate on the magnet.   Spin for 3-4s in the centrifuge if this condition is not met.

 

8. Next, Bravo will remove the waste �uid from the DNA plate \(Pos5).

 

8.1. Bravo will retrieve tips from the tip box at Pos3 and proceed to remove all of the liquid from the
DNA plate at Pos5. Pause the protocol when Bravo hovers above Pos5 and uncover the plate.

8.2. Bravo will dispense the waste �uid at Pos9. The tips will then be returned to Pos3.

 

9. Next, Bravo will perform two 70% ethanol washes.

 

9.1. Bravo will retrieve tips from the tip box at Pos2 and then aspirate 70% ethanol from Pos8.  
Pause the protocol when the Bravo machine hovers above Pos8 to remove the cover on the ethanol
plate \(Pos8).

9.2. The ethanol will be gently dispensed into the DNA plate \(Pos5).

9.3. Bravo will let the ethanol solution and the beads incubate for 30 seconds before aspirating all of
the liquid from the wells \(Pos5) and dispensing the waste �uid at Pos9.

9.4. Bravo will then perform a second identical ethanol wash.
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9.5. After the waste from the 2nd ethanol wash is dispensed at Pos9, set a timer for one minute. The
tips will then be returned to Pos2.

10. When the timer alarms, cover the plate \(Pos5) and let the plate dry for two additional minutes.

Note: Before continuing, inspect the reaction plate to make sure that all of the traces of ethanol are
evaporated. The beads should be completely dry but not cracked. Make sure the beads are not over-dried
as that reduces DNA recovery.

 

11. Next, Bravo will prompt you to move the DNA plate from Pos5 to Pos4 and to place the QEB plate
at Pos6. Do not move the DNA plate yet, but place the QEB plate at Pos6. Remove the cover on the
QEB plate and click ‘Continue’.

12. The program will then add 25 uL QEB \(Pos6) to the DNA plate \(Pos4) and incubate for a
minimum of four minutes.

12.1. Bravo will retrieve tips from the tip box at Pos1 and aspirate QEB from Pos6.

12.2. Bravo will then dispense the QEB into the DNA plate at Pos4.   Pause the protocol when the
machine hovers above Pos4. Uncover the DNA plate \(Pos5) and move it to Pos4.

12.3. The tips will then be returned to Pos1.

12.4. Cover the DNA plate \(Pos4) when the machine is no longer in motion.

 

13. While waiting for the protocol, prepare the PCR mastermix in a tube and aliquot into one row of a
new 96-well plate. Label this the “reservoir” plate.

 

14. Prepare the PCR brew in a 5 mL tube according to the following calculator:

                    

15. Aliquot 211 uL of the mix into one 12-well strip tube.

 

16. Change the tip box at position 2 on Bravo. Pause the program and update the tip editor with Box-
position2.

 

17. Place the master mix strip-tube on row A of a chilled cool-rack at position 7 on Bravo.
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18. Place a LoBind plate on a chilled cool-rack at position 6 on Bravo.

 

19. Place the elution plate back on the Bravo deck: on top of the magnet in position 5.  

 

20. The robot will �rst aliquot the master mix brew from the 12-well strip tube into the new LoBind
plate 23 uL/well at position 6. Then it will transfer \(Pos5) the elute DNA 25 uL/well into the brew
plate \(Pos6) and mix.

 

21. Using a P20 multichannel pipette, manually add 2 uL of the index primer from the Indexing
Primer plate to each reaction. Label this plate “PCR.”

 

22. Spin down the plate at 3000rpm, 4C, for 2min.

 

23. Incubate the “PCR” plate in the thermocycler using the program pcr-gsc using 7 cycles. Check the
cycle number and setting before starting PCR.

 

pcr-gsc program:

 

98°C for 1 minute

98°C for 30 seconds

65°C for 15 seconds

70°C for 15 seconds

70°C for 5 minutes

4°C forever
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15. Bead cleanup after PCR

 

1. Aliquot 50 uL of beads into each well of the “beads” plate. Do NOT use a reservoir for this step as
the beads will settle and the PEG concentration will not be consistent.

 

2. Set up the bravo exactly as stated in Bead-Cleanup and End-Repair \(step 7) except with the
following parameters:

 

                        DNA volume = 50 uL

                       Bead volume = 45 uL

Elution volume = 27 uL

 

3. The program will add the beads \(Pos6) to the DNA plate \(Pos4).

 

3.1. Bravo will retrieve tips from Pos3 and transfer 50uL of beads from Pos6 to the DNA plate at
Pos4 and mix. The tips will then be returned to Pos3.

 

3.2. Pause the protocol and cover the DNA plate.

 

4. The program will aliquot the ethanol into the 96 well reservoir \(Pos9àPos8)

 

4.1. Bravo will retrieve tips from the tip box at Pos2 and aliquot ethanol from the reservoir \(Pos9)
into the ethanol plate \(Pos8). Pause the program when the machine hovers above Pos9 to pour the
fresh 70% Ethanol into the reservoir. The tips will be returned to Pos2 after the last of the ethanol is
aliquoted.

4.2. Pause the program and cover the ethanol plate at Pos8.

5. The program will then incubate the DNA plate with the beads for 8 minutes \(10 minutes total).
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6. After incubation, the program will prompt you to put the plate on the magnet and replace the
ethanol reservoir from Pos9 with an empty Axygen 450 waste plate.

 

6.1. Place the plate on the magnet at Pos5 and incubate for two minutes \(set a timer).

6.2. Click ‘Continue’ when the timer alarms and incubate for an additional 3.5 minutes.

 

Note: Check the walls of the wells to ensure that all of the liquid is at the bottom of the well before
placing the plate on the magnet. Spin for 3-4s in the centrifuge if this condition is not met.

 

7. Next, Bravo will remove the waste �uid from the DNA plate \(Pos5).

 

7.1. Bravo will retrieve tips from the tip box at Pos3 and proceed to remove all of the liquid from the
DNA plate at Pos5. Pause the protocol when Bravo hovers above Pos5 and uncover the plate.

7.2. Bravo will dispense the waste �uid at Pos9. The tips will then be returned to Pos3.

 

8. Next, Bravo will perform two 70% ethanol washes.

 

8.1. Bravo will retrieve tips from the tip box at Pos2 and then aspirate 70% ethanol from Pos8.  
Pause the protocol when the Bravo machine hovers above Pos8 to remove the cover on the ethanol
plate \(Pos8).

8.2. The ethanol will be gently dispensed into the DNA plate \(Pos5).

8.3. Bravo will let the ethanol solution and the beads incubate for 30 seconds before aspirating all of
the liquid from the wells \(Pos5) and dispensing the waste �uid at Pos9.

8.4. Bravo will then perform a second identical ethanol wash.

8.5. After the waste from the 2nd ethanol wash is dispensed at Pos9, set a timer for one minute. The
tips will then be returned to Pos2.

 

9. When the timer alarms, cover the plate \(Pos5) and let the plate dry for two additional minutes.
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Note: Before continuing, inspect the reaction plate to make sure that all of the traces of ethanol are
evaporated. The beads should be completely dry but not cracked. Make sure the beads are not over-dried
as that reduces DNA recovery.

 

10. Next, Bravo will prompt you to move the DNA plate from Pos5 to Pos4 and to place the QEB plate
at Pos6. Do not move the DNA plate yet, but place the QEB plate at Pos6. Remove the cover on the
QEB plate and click ‘Continue’.

 

11. The program will then add 27 uL QEB \(Pos6) to the DNA plate \(Pos4) and incubate for a
minimum of four minutes.

 

11.1. Bravo will retrieve tips from the tip box at Pos1 and aspirate QEB from Pos6.

11.2. Bravo will then dispense the QEB into the DNA plate at Pos4.   Pause the protocol when the
machine hovers above Pos4. Uncover the DNA plate \(Pos5) and move it to Pos4.

11.3. The tips will then be returned to Pos1.

11.4. While the DNA is eluting, cover the DNA plate \(Pos4) when the machine is no longer in motion.

11.5. After the incubation for the DNA elution is over, spin the plate for 10-20 seconds in plate
centrifuge.

11.6. Place the plate on the magnet \(Pos5) and uncover the plate.

 

12. Place a new \(labelled) LoBind plate at Pos6. Bravo should elute the supernatant directly into
new plate.

 

13. Cover the plate with a plastic cover, spin down at 2000g for 1min, 4°C.   Proceed to the next step
or seal with an aluminum cover and store at -20˚C.

 

1�. qPCR QC
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1. Work at post-PCR bench. Perform all work on ice.

 

2. Place a 384 well coolrack in -20˚C freezer to chill. Get fresh ice.

 

3. Turn on ViiA7 and it’s computer. Open the program ViiA 7 1.2.

 

4. Wipe down and turn on Bravo. Make sure it is 96ST head. Load VWorks as described previously.
Choose program: PBAL-qPCR pro.

 

5. Label a clean 96 well plate as a “reservoir”. Prepare two 1.5ml amber vials for qPCR brew on ice.
Label one as “target”, the other one as “library”.

 

6. Prepare the brews according to the following calculators.

 

 

7. Aliquot 76 uL/well of the target brew into one row of reservoir plate, label the row “target”.

 

8. Aliquot 76 uL/well of the library brew into second row of reservoir plate, label the row “library”.

 

9. Retrieve qPCR-384 well plate. Mark A1 at A1 corner. Mark on the left of wells the rows for target
reactions, use quadrant A. Mark on the right of the wells the rows for library reactions, use quadrant
4.

 

10. Working on ice, aliquot 9 uL of brew into each well as de�ned from reservoir.

 

11. Add negative qPCR control wells \(9 uL of brew) manually to the bottom right corner of the plate.
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11.1. Negative control for target: O22 and O24

11.2. Negative control for library: P21 and P23.

 

12. Cover the qPCR plate and keep it on ice. Keep the plate protected from light.

 

13. Pour EB buffer \(post-PCR) into a reservoir and using P200 multichannel aliquot 100uL/well into
a 96 well plate and cover with a plastic seal.

 

14. Set up Bravo deck as per image below:

                         

         Position 1: empty 384 tip box
Position 2: empty
Position 3: new box of 384 tip box
Position 4: coolrack + DNA sample plate
Position 5: chilled coolrack + 384 qPCR plate with brew
Position 6: coolrack + EB buffer plate 
Position 7, 8, 9, empty

 

15. Click “Run protocol”. VWorks will prompt you to con�gure the tip state editor.

 

16. Select Pause, click on Tools, then Tip State Editor. Click “…” button on the right of the tip box
name and adjust the tip state to match the tip boxes on the Bravo deck. Repeat for all tip boxes.

           Hit Continue and start the Bravo process.

 

17. The Bravo will add the DNA into the target wells and dilute the DNA 1:100 in EB buffer before
transferring into library wells.
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18. After Bravo program is done remove the plate from the Bravo deck.

 

19. Seal the plate very well with a MicroAmp optical qPCR cover. Use the MicroAmp Adhesive Film
Applicator to create a good seal, especially on the perimeter of the plate.  

 

20. Spin the plate down at 3000 rpm, for 1 min, at 4°C. Place the plate inside the ViiA7 instrument.

             Make sure that A1-well matches the A1 position on the tray.

 

21. In the ViiA 7 software click “New experiment”.   Set up plate. After set up save it as template �le
**.edt for later use.

Target will be quadrant 1, and Library will be quadrant 4. \(e.g. �gure below)

Negative control for target: O22 and O24

Negative control for library: P21 and P23

22. After set up the template, check that the cycle settings are correct:

               98°C for 1min

               98°C for 15 sec

               60°C for 30 sec

               72°C for 30 sec

 

23. The reaction volume should be 10uL and the passive reference should be set to none.

 

24. Save qPCR run to your folder, name it with plate label and date.

            

25. Hit “Run” button, the qPCR will start. Leave qPCR running overnight or if possible, wait for the
qPCR results.   If you wait for the qPCR, complete the pooling and ethanol precipitation step so it can
be incubated at -20oC for overnight.
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26. Clean up your workstation. Remove garbage. This concludes Day 3 of this protocol.

 

DAY 4

17. qPCR Analysis, sample pooling and precipitation

 

1. Analyze qPCR data using qPCR pipeline.Rmd following instructions.

 

1.1. instructions:

 

# 1. Change the title to desired �le name

# 2. Select the correct excel �le \(press tab betwene quotes, choose from the list)

# 3. Make sure the wells are de�ned \(positive, negative, tencell,hundredcell)

# 4. Set cutoff to be between 8-10

# 5. Press "Knit HTML"

# 6. View the plot, if needed, adjust cut off value slightly

# 7. Press "Knit HTML" again

# 8. Check through �gures, save/print results and con�rm correct �le names

# 9. Upload to JIRA, under the appropriate library construction ticket

 

\`\`\`

1.2. De�ne a cutoff for success

Successful passed samples will cluster well in plot �gure, the cutoff should be set right above the
clustered plots. For example:

1.3. Check that there are no systematic errors with the plate
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2. Percentage of passed samples should be above 75-80%. Check that the average CT values of the
passed wells is consistent with previous sample plates \(Target and Library).

Note: Average CT value for Target should be between 21-23, average CT value for Library should be
between 13-15. Delta CT between Target_Ct and Library_Ct should be between 6-9.

 

3. Working on ice, pool all of the passed wells and negative controls together into a 2mL tube.
Exclude failed wells and positive controls \(usually G1 or as marked).

 

4. Measure the total volume and, working on ice, set up ethanol precipitation as follows:

                     X \(volume pooled in uL)

                     0.1*X of 3M Sodium Acetate pH 5.5 \(in uL)

 

5. Mix well by pulse-vortexing.   Add 1.3 uL mussel glycogen \(marked as MG, 20mg/mL) and mix
well by pulse-vortexing.

 

6. Calculate the total volume and add 2.5X\(total volume in uL) of cold 100% ethanol.   Vortex
thoroughly. It is important that the solution is very well mixed. Split the volume across multiple
1.5mL tubes.

 

7. Incubate precipitations at -20˚C for at least 2 hour but overnight is preferred.

 

8. While waiting, pre-chill the centrifuge to 4˚C.

 

9. After -20˚C incubation, place all tubes in the same orientation in the pre-chilled to 4°C centrifuge.

 

10. Spin down at 15,000g \(max rpm) at 4°C, for 40 min.
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11. Prepare fresh 70% ethanol using ultrapure water. Take out and aliquot of 20% PEG SeraMag
beads to warm up to room temperature for at least 30 min.

 

Note: The following steps must be performed on ice.

 

12. After centrifugation visually locate the pellet. Carefully discard the supernatant while avoiding the
DNA pellet.

 

13. Add 1mL of 70% ethanol, plate the tube inside the centrifuge in the same orientation as before,
and spin down at 15000g \(max rpm) at 4°C, for 4 min.

 

14. After centrifugation visually locate the pellet and carefully aspirate the supernatant.

 

15. Spin down the tube in minifuge to collect all of the ethanol on the bottom. With P10 remove the
�nal traces of ethanol.

 

16. Dry the pellet at room temperature until the pellet becomes translucent \(maximum 5 minutes).

           Keep a close eye on the pellets so that they do not over-dry.

 

17. When the pellet becomes clear, resuspend the DNA in each tube with 20 uL of room temperature
EB buffer.   Mix up and down with the pipette.  

 

18. After the pellets are fully dissolved, pool all volume into one tube. Measure the volume and top up
with EB buffer to a multiple of 50uL.   For example, if the volume is 80uL add an additional 20uL of
EB buffer to a total volume 100uL \(which is 2X 50uL).
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1�. Library pool puri�cation using SeraMag beads

 

1. Make sure that the 20% SeraMag beads have fully reached room temperature before proceeding
and use freshly made \(on the same day) 70% ethanol.

 

2. Working at post PCR work station, using a single channel P100, aliquot the pooled and
precipitated single cell PCR library products - 50uL per well into one row of a new LoBind plate.

 

3. Mix the 20% SeraMag beads very well and aliquot 55ul per well into one row of a reservoir plate \
(corresponding to the number of DNA wells).   Using P200 multichannel, to each 50uL of DNA add
45uL of room temperature 20%PEG SeraMag beads \(0.9X ratio) and immediately mix by pipetting
up and down at least 10X.

 

4. Incubate at room temperature for 10 min.

 

5. After 10min incubation move the plate to the magnet and incubate for 3 min. Make sure that all of
the beads are separated to the sides and the solution is completely clear before proceeding.  

 

6. Keep the plate on the magnet for the next few steps.

 

7. Without disturbing the beads, using a single channel P200, carefully remove the clear supernatant.
Make sure not to remove any beads.

 

8. On the magnet, using multichannel P200, add 150ul of 70% ethanol and incubate for 30 seconds.

 

9. From each well, carefully aspirate the ethanol using single channel P200.
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10. Using multichannel P200, add 150uL 70% ethanol and incubate for 30 seconds.

 

11. From each well, using single channel P200 set to 170uL, carefully remove all of the ethanol.

12. After the second wash keep the plate still on the magnet. Using P10 aspirate the remaining traces
of ethanol from the bottom of each well.   Make sure not to remove any beads,

 

13. Let the beads dry at room temperature for 2 min. Do not over-dry the beads. You should not see
any cracks.

 

14. When the beads are dry, remove the plate from the magnet. Using P20, add 15uL of EB buffer and
mix very well by pipetting up and down.   Make sure that all of the beads are re-suspended. The
solution should be uniformly brown.

 

15. Incubate at room temperature for 3min.

 

16. After 3min elution, place the plate back onto the magnet and incubate for 1 min. Make sure that
all of the beads are pulled to the sides and the solution is completely clear.  

 

17. After 1min incubation, using P20 carefully transfer the supernatant \(containing the eluted DNA)
into a new 1.5 mL tube. Label the tube with sample/pool ID.

 

18. Use 1uL of the sample for Qubit assay and run another 1uL on HS Agilent to observe the
fragment distribution. Expected yield should be > 1 ng/uL. Average size of the �nal product should
be around 300bp.
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19. Store the sample at -20C until ready for sequencing.   Record all of the data in your notebook.

 

20. Clean up your workstation. Remove garbage. This concludes Day 4 of this protocol.

Figures

Figure 1

Sorting plate layout (Step 3.1)
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Figure 2

Lysis Brew Table

Figure 3

Silica beads calculator

Figure 4

Magnum FLX magnet


